The Mathcad Working Model

What Mathcad can do...

How to try it out...

Menu commands...

Context sensitive help on:
functions
error messages
operators

alette buttons
menu commands



Help on functions

To learn what a specific function does:

b Choose Insert Function from the Math menu.

L Click on the name of the function in the left-hand scrolling list.

3 Look on the right-hand scrolling list to see what the function does.



Help on error messages

If you want to know more about what a particular error messages means:
L Press Shift+F1.
3

Click on the error messages you're interested in.
3

When you're done, press Esc.



Help on operators and Greek letters

To get help on anything appearing on the palette along the left side of the window:

L Press Shift+F1.

] Click on the palette button you're interested in and read the message line at the bottom of the
window.

L When you're done, press Esc.



Help on menu commands

For help on menu commands:
L Press Shift+F1.

L Click on the menu command you're interested in.
r When you're done, press Esc.



What Mathcad can do
To learn more about what Mathcad can do, choose Open Mathcad Demo from the Books menu.
This opens a live interactive document demonstrating many of Mathcad's features.



Trying out Mathcad
To try out some of Mathcad's features, choose Open Scratchpad from the Books menu. This will
open up a window in which you can try out many of the features you learned about in the Mathcad
Demo Book.
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BOOKS MENU

Books = Open Mathcad Demo

Books = Open Scratchpad
Books = Search Book...

Books = Close
Books = Exit




EDIT MENU

Edit = Undo Last Edit
Edit = Cut

Edit = Copy

Edit = Paste

Edit = View Regions

Edit = Insert Pagebreak
Edit = Set Right Margin
Edit = Clear Right Margin
Edit = Go to Page...




TEXT MENU

Text = Create Text Region
Text = Change Font...
Text = Change Default Font...




MATH MENU

Math = Matrices...

Math = Built-In Variables...
Math = Units = Insert Unit...
Math = Units = Change System of Units...
Math = Insert Function...
Math = Randomize...

Math = Calculate

Math = Calculate Document
Math = Toggle Equation
Math = Automatic Mode
Math = Numerical Format...

Math = Apply Font Tag...
Math = Modify Font Tag...
Math = Change to Greek Variable




GRAPHICS MENU

Graphics = Create X-Y Plot
Graphics = Create Polar Plot
Graphics = Create Surface Plot
Graphics = Create Contour Plot
Graphics = X-Y Plot Format...

Graphics = Polar Plot Format...




X-Y PLOT MENU

Available only when an x-y plot is selected.

X-Y Plot = Format...

X-Y Plot = Crosshair...
X-Y Plot = Zoom...

X-Y Plot = Title...

X-Y Plot = Axis Labels...




POLAR PLOT MENU

Available only when a polar plot is selected.

Polar Plot = Format...
Polar Plot = Crosshair...
Polar Plot = Zoom...
Polar Plot = Title...




CONTOUR PLOT MENU

Available only when a contour plot is selected.

Contour Plot = Format...
Contour Plot = Title...




SURFACE PLOT MENU

Available only when a surface plot is selected.

Surface Plot = Format...
Surface Plot = Title...




WINDOW MENU

Window = Cascade
Window = Tile

Window = Arrange Icons
Window = Zoom...
Window => Refresh
Window = Hide Palette
Window = Hide Tool Bar
Window => Hide Font Bar

Window = Change Colors = Background Color...
Window = Change Colors = Text Color...
Window = Change Colors = Equation Coilor...
Window = Change Colors = Annotation Color...




HELP MENU

Help = Contents...

Help = Keyboard...

Help = Using Help...

Help = About the Mathcad Working Model...
Help = What is Mathcad...







Books = Open Mathcad Demo...

Opens an Electronic Book illustrating Mathcad's features and providing instructions on how to use
this demo version of Mathcad.



Books = Open Scratchpad

Opens another window in which you can try out some of Mathcad's features to perform calculations
and create plots.



Books = Search Book...

Opens a dialog box into which you type a string you want to search for.



Books = Close

Closes the active window.

Keyboard shortcut Ctrl+F4



Books = Exit

Exits this demo.

Keyboard shortcut Alt+F4









Edit = Undo Last Edit

Undoes your most recent edit command or keystroke.

Keyboard shortcut Alt+BkSp



Edit = Cut
Deletes whatever has been selected and places it on the clipboard.

Note that only the most recently cut selection is on the clipboard.

Keyboard shortcuts Ctrl+X



Edit = Copy

Copies whatever has been selected to the clipboard. Following this command, you should usually
choose Paste from the Edit menu.

Keyboard shortcuts Ctrl+C



Edit = Paste
Places whatever is in the clipboard into the document.

This operation does not change the contents of the clipboard.

Keyboard shortcuts Ctrl+V



Edit = View Regions
Encloses all regions in boxes so you can see how big they are and where their anchor points fall.

To restore the normal document view, choose this again.



Edit = Insert Pagebreak
Inserts a pagebreak wherever the cursor is located.

To delete a pagebreak, click where the line indicating the pagebreak touches the left edge of your
document. Then choose Cut from the Edit menu.



Edit = Set Right Margin

Sets the right margin to the current location of your crosshair.



Edit = Clear Right Margin

Removes the right margin.



Edit = Go to Page...

Jumps to a particular page. Mathcad puts the top of the page you jump to at the top of your window.






Text = Create Text Region

Creates a region of text wherever the crosshair is. The crosshair will change into a thin vertical line.
A box appears showing the extent of the text region. This box disappears when you click outside
the region.

You can change the width of a text region by selecting it and dragging on the right edge of the
selection rectangle with the mouse.

Keyboard shortcut " (double-quote)



Text = Change Font...
Brings up a dialog box for changing the font, size and style of selected text.

The text must be in a text band or region. To change fonts in equations, choose Apply Font Tag or
Modify Font Tag from the Math menu.



Text = Change Default Font...
Brings up a dialog box for changing the default font of all text regions and text bands.
Text in fonts other than the default font is unaffected.

This command affects only text regions and text bands. To change math fonts, choose either Apply
Font Tag or Modify Font Tag from the Math menu.






Math = Matrices...
Creates a vector or matrix wherever the crosshair is located.

If the crosshair is already in a vector or matrix, choosing this allows you to insert or delete a row or
column.

Keyboard shortcut Ctrl+M



Math = Built-In Variables...

Changes the values of the built-in variables:
TOL
PRNPRECISION
ORIGIN
PRNCOLWIDTH

v v v v



Math = Units = Insert Unit...

Brings up dialog box with a scrolling list of built-in units.

To express a result in one of Mathcad's built-in units:
Click on the unit placeholder to the right of a result.
Highlight the unit in the scrolling list of units.
Click Insert. Mathcad inserts the unit and converts the result appropriately.

Keyboard shortcut Ctrl+U



Math = Units = Change System of Units...

Changes the default system of units. By default, Mathcad displays results in terms of m, kg, sec,
coul and K. You can change this to CGS, US or none.



Math = Insert Function...
Brings up dialog box with a scrolling list of built-in functions.

To see what a particular function does, click on the function name and read the text that appears in
the box on the right.

To insert a built-in function, together with the necessary placeholders:
] Highlight the function name in the scrolling list of units.
b Click Insert.



Math = Randomize...

Changes the value of the seed used in Mathcad's rnd(x) function to generate uniformly distributed
random numbers between 0 and x.

If you choose this without changing the seed, Mathcad restarts the random number sequence using
this seed value.



Math = Calculate

Updates all plots and numerical results on the screen. Mathcad places the words "calc F9" in the
message line to let you know that the screen needs to be updated.

If you want to update all plots and numerical results throughout the document, choose Calculate
Document from the Math menu instead.

Keyboard shortcut F9



Math = Calculate Document
Updates all plots and numerical results throughout the document.

If you want to update only the plots and numerical results currently displayed, choose Calculate
from the Math menu instead.



Math = Toggle Equation

Makes Mathcad ignore a selected equation in all calculations. Disabled equations are marked with
a small box.

If a selected equation is already disabled, this command re-enables it.

This menu command allows you to use Mathcad's equation typesetting ability independently of its
calculation features.



Math = Automatic Mode
Toggles between manual and automatic mode.

If checked, Mathcad automatically updates the screen whenever you make a change in the
document.

If unchecked, Mathcad won't update the screen until you press F9 to force recalculation.

When editing a document that involves lengthy calculations, you may find it more efficient to work in
manual mode.



Math = Numerical Format...
Controls how a particular numerical result is displayed.

To change the way all numbers are displayed, click in an empty region, choose this, and click on
Global in the dialog box.

You can control
The number of decimal places displayed.
How big or small a result must be before it's displayed in exponential form.
How small a result must be before it's displayed as zero. (Global only)
How small the real or imaginary part must be before it's suppressed.
Whether Mathcad uses i or j for imaginary numbers. (Global only)
Whether the number is hex, octal or decimal.
Whether trailing zeros are used to indicate the precision of the number displayed.
How large a matrix has to be before Mathcad shows it as a scrolling output table.

A . . . . S .

Mouse shortcut Double-click on result



Math = Apply Font Tag...
Displays a list of available font tags.
To tag a variable, click on it and choose the appropriate font tag from the list.

To see what font, size and style go with a given tag, choose Modify Font Tag from the Math menu.



Math = Modify Font Tag...

Displays a list of available font tags together with the font, size and style assigned to each one. You
can use this dialog box to add additional font tags or change existing ones.

Note that if you change the font associated with an existing font tag, you change the font of every
variable sharing that tag.



Math = Change to Greek Variable

Changes the letter behind the insertion point to a corresponding Greek letter.

L Type the appropriate roman letter from the table below.
g Choose this menu command.
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Keyboard shortcut Ctrl+G









Graphics = Create X-Y Plot

Creates a graph with either linear, log, or semilog axes. The plot will contain placeholders for x and
y values as well as endpoints of the axes.

To change the axes, legends, plot style and other plot characteristics, choose X-Y Plot Format
from this same menu.

Keyboard shortcut @



Graphics = Create Polar Plot
Creates a polar plot with placeholders for an angle variable and a radial expression.

To change the size and other plot characteristics, choose Polar Plot Format from this same menu.

Keyboard shortcut Ctrl+7



Graphics = Create Surface Plot

Creates a surface plot with a placeholder for an array to be plotted. The rows and columns will
correspond to the x and y axes. The value in the array will represent the height above the xy plane.

To change the size and other plot characteristics, click on the plot and choose Format from the
Surface Plot menu.

Keyboard shortcut Ctrl+2



Graphics = Create Contour Plot

Creates a contour plot with a placeholder for a matrix to be plotted. The rows and columns will
correspond to the x and y axes. This provides a visual representation of the level curves of the
matrix.

To change the size and other plot characteristics, choose Contour Plot Format from this same
menu.

Keyboard shortcut Ctrl+5



Graphics = X-Y Plot Format...

Controls the characteristics of all graphs in the document. Use this to control:
tick marks
gridlines
type of curve (bar, line, etc...)
color of curve
legends
type of axis (linear or log)
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Graphics = Polar Plot Format...

Controls the characteristics of the selected polar plot; click on the graph and choose this.

Mouse shortcut Double-click on polar plot



X-Y Plot = Format...

Controls the characteristics of the selected graph. Use this to control:
3 tick marks

gridlines

type of curve (bar, line, etc...)

color of curve

legends

type of axis (linear or log)

v v vy v w

Mouse shortcut Double-click on graph



X-Y Plot = Crosshair...

Allows you to read coordinates directly from the selected graph.



X-Y Plot = Zoom...

Allows you to zoom in on the selected graph for a close-up view.



X-Y Plot = Title...

Lets you specify a title above or below the graph.



X-Y Plot = Axis Labels...

Lets you specify a label below the x-axis, beside the y-axis, or both.



Polar Plot = Format...

Controls the characteristics of the selected polar plot. Use this to control:
tick marks
gridlines
type of curve (bar, line, etc...)
color of curve
legends
type of radial axis (linear or log)
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Mouse shortcut Double-click on polar plot



Polar Plot = Crosshair...

Allows you to read coordinates directly from the selected polar plot.



Polar Plot = Zoom...

Allows you to zoom in on the selected polar plot for a close-up view.



Polar Plot = Title...

Lets you specify a title above or below the polar plot.



Contour Plot = Format...

Controls the characteristics of the selected contour plot. Use this to control:
presence of numbers on contours
gridlines
how many contours there are
shading and color

v v v v

Mouse shortcut Double-click on contour plot



Contour Plot = Title...

Lets you specify a title above or below the contour plot.



Surface Plot = Format...

Controls the characteristics of the selected surface plot. Use this to control:
viewing angle
vertical scale (how "bumpy" the plot is)
hidden lines
axes
shading and color

v v v v w

Mouse shortcut Double-click on surface plot



Surface Plot = Title...

Lets you specify a title above or below the surface plot.






Window => Cascade

Hides inactive document windows behind the active window without obscuring any title bars.



Window = Tile

Arranges all document windows so that they:
3 all have the same area
r completely cover the Mathcad window.



Window = Arrange Icons

When you close a document, an icon appears in the lower left corner of the application window.
Choose this to arrange all these icons neatly.



Window = Zoom...
Zooms in for a close-up view by making this number larger than 100%.

To bring unseen portions of a document into view or to display an entire document, make this
number smaller than 100%.



Window = Refresh

Redraws the screen.

Keyboard shortcut Ctrl+R



Window = Hide Palette

Hides the symbol palette on the left of the Mathcad window. If the palette is already hidden, this
command displays it.



Window = Hide Tool Bar

Hides the tool bar. If the tool bar is already hidden, this command displays it.



Window = Hide Font Bar

Hides the font bar. If the font bar is already hidden, this command displays it.



Window = Change Colors = Background Color...

Brings up a palette of colors for changing the background color of the application window.



Window = Change Colors = Text Color...

Brings up a palette of colors for changing the color in which Mathcad displays text.



Window = Change Colors = Equation Color...

Brings up a palette of colors for changing the color in which Mathcad displays equations.



Window = Change Colors = Annotation Color...

Brings up a palette of colors for changing the color in which Mathcad highlights any changes you've
made to an Electronic Book.



Help = Contents...

Provides help on menu commands and tells you how to start going through this demo.

Keyboard shortcut F1



Help = Keyboard...

Opens a window containing help on all keystrokes.



Help = Using Help...

Opens a window containing instructions for using the Mathcad Help system.



Help = About the Mathcad Working Model

Shows the version number of this demo.



Help = What is Mathcad...

Describes what Mathcad is and what kinds of things you can do with it.






ERROR MESSAGES

array size mismatch
cannot be defined

cannot take subscript
cannot take superscript
definition stack overflow
did not find solution
dimension to nonreal power
domain error

duplicate

end of file

equation too large

error in constant

error in list

error in solve block

file error

file not found

illegal array operation
illegal context

illegal factor

illegal function name
illegal ORIGIN

illegal range

illegal tolerance
incompatible units

indeterminate dimension
index out of bounds
invalid order

interrupted

list too long

misplaced comma
missing operand
missing operator

must be 3-vector

must be a multidimensional array
must be array

must be dimensionless
must be increasing
must be integer

must be nonzero

must be positive

must be range
must be real

must be scalar

must be square

must be vector

nested solve block

no matching Given
non-scalar value

not a name

not converging

not enough memory
only one array allowed




overflow

range not allowed
significance lost
singularity

stack overflow
subscript too large
symbolic operator only

too few arguments
too few constraints

too few elements

too few subscripts
too large to compute
too large to display
too many arguments
too many constraints
too many points

too many subscripts
undefined

underflow

unmatched parenthesis
wrong size vector




array size mismatch

You tried to perform a vector or matrix operation on arrays whose sizes are inappropriate. For
example, adding two unequal size matrices is illegal. Matrix multiplication requires that the number
of columns in the first matrix match the number of rows in the second.



cannot be defined

Something other than a legally definable expression is on the left side of this definition. Mathcad
accepts any of the following on the left side of a definition:

A variable name.

A variable name with a subscript.

A variable name with a superscript.

An explicit vector or matrix generated by typing Ctrl+M. The vector or matrix can hold variable

ames or subscripted variable names only.
A function name with arguments: f(x,y).

v J v v v w

Any other expression is illegal. If you want to compute a result instead of defining a variable, use
an equals sign '=' instead of a colon.



cannot take subscript

You used a subscript on something other than a vector or a matrix.



cannot take superscript

You used a superscript on something other than a vector or a matrix.



definition stack overflow

This function definition contains too many nested functions.



did not find a solution

In a solve block, Mathcad couldn't find a solution. Try raising the value of TOL or using the minerr
function instead of the find function.



dimension to nonreal power

This expression contains units that have been raised to a complex power. An expression with units
can only be raised to a real power.



domain error

You attempted to evaluate an operator or a function at an inappropriate value. For example, In(0)
will give this error. So will -3! because factorial is undefined for negative numbers.



duplicate

You tried to evaluate the same variable twice in the same definition. For example, if you create a
vector on the left side of a := and use the same name in more than one element, you will get this
error.



equation too large

This expression is too complicated for Mathcad to evaluate. Break the equation down into two or
more smaller expressions.



error in constant

This expression contains a digit or a decimal point followed by some letters. Mathcad tries to
interpret anything beginning with a digit or a decimal point as a constant.

Sometimes this arises when you leave out the * operator as you would when writing equations on

paper. For example, writing 6x instead of 6*x is often done on paper, but generates this error in
Mathcad.



error in list

The indicated function definition contains an invalid list of arguments. A valid function definition
begins like this:

functionname(argument list) := ...

The argument list must be a name or a list of names separated by commas. Any other expression
is illegal.

You also see this error message if you create an invalid list in another context, for example, in the
list of y-axis expressions for a plot.



error in solve block

You see this error if you evaluate a user function that is defined in terms of a solve block with an
error in it.

To fix the error, fix the problem in the solve block. If you evaluate the solve block directly, instead of
defining a function with it, you will see a more specific error message.



file error
The file you are trying to access with READ or READPRN does not have the required format.

The file must be ASCII with spaces or tabs separating the numbers.



file not found

This expression refers to a file Mathcad was unable to find the file specified in the argument to
READ, READPRN, APPEND, or APPENDPRN.



illegal array operation

One of the functions or operators in this expression has received a vector or matrix when it was
expecting a scalar.

For example, you see this message if you try to divide one vector by another.

If you want to apply a function or operator to every element in a vector or matrix, use the vectorize
operator Ctrl+-.



illegal context

The most common causes of this error message are:

L You entered a semicolon somewhere other than in a legal range definition. (The semicolon
appears as two dots.)

[ You used a WRITE or APPEND function anywhere other than on the left side of a definition.
These functions should not be on the right side of a definition.

L You used an existing function name as a variable name or an existing variable name as a function
name.

b You used a

¥ in a solve block.



illegal factor

You entered an illegal expression in the placeholder at the end of a calculation equation. This
placeholder requires real, non-zero, scalar values.



illegal function name

You used an expression that Mathcad interprets as a function, but the function name is invalid. You
see this error, for example, if you use a number as a function name: 6(x).

You may see this error if you omit an operator like *, causing Mathcad to interpret the parentheses
in your equation as defining a function instead of as a way to group operations. This often happens
because in algebra books, something like 3(x+2) means 3x + 6. In Mathcad, you must type
3*(x+2).



illegal ORIGIN

You defined ORIGIN to be either non-integer, or an integer whose magnitude is greater than
16,000,000.

This error marks the first use of a subscript after the illegal definition of ORIGIN.



illegal range

You defined a range variable with a range Mathcad could not interpret. When you define a range,
you must use one of the following forms:

L Rvar := n1 ..n2 (type Rvar:n1;n2)

3 Rvar :=n1,n2 ..n3 (type Rvar:n1,n2;n3)

You can use at most one comma and one semicolon in the definition of a range for a range
variable. If you use the second form, the value of n2 must lie between the values of n1 and n3, but
not equal n1.



illegal TOL
The built-in constant TOL is outside the allowable range.

To fix the error, define TOL with a value between 0 and 1 above the indicated expression.



incompatible units

This error message has three likely causes:

L You are adding or subtracting two terms having different dimensions.
[ You have created a matrix, vector or table in which not all elements have the same dimensions.
L You have created a plot in which two expressions having different dimensions share the same

axis.



indeterminate dimension

You have raised an expression involving units to something other than a real power. Mathcad
cannot determine the dimensions of the result. If an expression is defined with units, you can raise
it only to a fixed real power.



index out of bounds
This expression uses a subscript or superscript that refers to a nonexistent array element.

Keep in mind that unless you specify otherwise, all Mathcad arrays begin with Oth element. If you
are used to thinking of arrays as beginning at the 1st element, reset ORIGIN to 1.



invalid order

Order is not one of the following numbers: 0,1,2...5.



interrupted
You interrupted a calculation pressing Esc.

To recalculate the marked equation, put the cursor in the equation and press F9.



list too long

You entered too many elements in a list separated by commas. This can occur if you try to plot
more expressions than Mathcad's capacity.



misplaced comma

Commas can be used to separate:
the arguments of a function,
the first two elements of a range in the definition of a range variable,
expressions in a plot,
elements in an input table,
subscripts in a matrix.

v v v v w

Any other use of commas is illegal in Mathcad expressions.



missing operand

You have not filled in the indicated placeholders. You should place numbers or expressions in these
placeholders.



missing operator

This expression is missing an operator at the indicated location.



must be 3-vector

The vector cross product is defined only for vectors having three elements.



must be a multidimensional array

You performed an operation that requires a matrix. For example, when creating surface plots or
contour plots, the array plotted must be a matrix, an array having at least two rows or two columns.
Certain built-in functions also require matrix arguments.



must be array

You performed an operation that requires an array on a scalar. For example, you see this error if

you define a superscripted variable as a scalar. Since a superscripted variable represents a column
of a matrix, you must define it as a vector.

For surface plots or contour plots, the array plotted must have at least two rows or two columns.



must be dimensionless
This expression uses units somewhere units are not permitted.

Units are not permitted:
3 in the arguments of most functions,
3 in exponents,
] in subscripts and superscripts.



must be increasing

The first argument of Ispline, pspline, cspline, linterp, and hist, as well as the second argument
of interp, must be a vector whose elements are strictly increasing.

Note that all vectors start at the Oth element unless you specifically set ORIGIN to 1. If you do not
explicitly define the Oth element, Mathcad sets it to zero.



must be integer
This expression contains a non-integer expression where an integer is required.

Some possible places to look are:
r Superscripts and subscripts
3 Arguments to certain functions such as identity, Bessel functions of integer order, csort, rsort,
Kronecker delta, antisymmetric tensor function.

Note that although you can define range variables with fractional values, you cannot use these as
subscripts or superscripts.



must be nonzero

This function is undefined at zero.



must be positive
This plot has a logarithmic axis in which either the limits, or some of the values are not positive.

Negative numbers and zero cannot be placed anywhere on a logarithmic axis.



must be range
This expression requires a range variable.
If the expression contains either a summation or an iterated product, check to see that the index is

in fact a range variable. The index is directly under the sigma or pi. It should have been defined in
an earlier statement.



must be real

This expression contains an imaginary or complex valued expression somewhere in which it is not
allowed.

Examples are subscripts and superscripts, arguments to Bessel functions, the Heaviside step
function, mod, and angle.



must be scalar

You used a vector or matrix expression where a scalar is required.



must be square

This error marks a non-square matrix in an operation or function that requires a square matrix,
such as determinants, inverse, raising to a power, or the eigenvals and eigenvec functions.



must be vector

This error marks a matrix or scalar in an operation that requires a vector, for example, with the
vector sum operator.



nested solve block

You used two "Given'"s in a row with no intervening find or minerr. Mathcad does not allow nested
solve blocks.

You can however, define functions with solve blocks and use those function in other solve blocks.



no matching Given

This error marks a find or minerr function with no matching Given. Each solve block that ends with
find or minerr must begin with a region containing only the name Given.



non-scalar value
You used a vector or ranged expression where a scalar is required.

For example, you see this message if i is a range variable and you try to enter an equation like x :=
i. You cannot define one range variable in terms of another.



not a name

You used a number or other combination of symbols where Mathcad requires a name, for example,
as the second argument of the root function.



not converging

Mathcad was unable to compute an answer for an integral, derivative, root, find, or minerr
function within the required tolerance. Try setting TOL to be larger, or try a different guess value.



not enough memory

Mathcad was unable to compute an array or matrix because of insufficient memory. Try to free up
some memory by making the array or matrix smaller or by deleting any large bitmaps, arrays, or
matrices.



only one array allowed

You entered more than one array in the placeholder of a contour plot. Mathcad will only accept one
array at a time because contour plots can only represent a single surface at a time.



overflow

You evaluated an expression that exceeds the largest number that Mathcad can represent.



significance lost or significance reduced

These error messages indicate that you tried to evaluate a function for a value beyond the accurate
range for the function.

For example, you see this message if you try to evaluate sin(10100). Since the value of
sin(107100) depends on the ones digit of 102100, any value that Mathcad could return would have

no significant digits. Instead of returning a value of dubious accuracy, Mathcad shows one of these
error message.



singularity

You evaluated a function or performed an operation at an illegal value. For example, you see this
error if you divide by zero or if you try to invert a singular matrix.



stack overflow

This expression overflows Mathcad's internal stack. Simplify the expression or divide it into two
subexpressions.



subscript too large

You tried to use a subscript or superscript that exceeds Mathcad's limit.



symbolic operator only

You have tried to evaluate an expression numerically when it must be evaluated symbolically.
When using operators such as the indefinite integral, you must select the expression and choose
Evaluate Symbolically from the Symbolic menu.



too few arguments
This expression contains a function with fewer than the required number of arguments.

For built-in functions, click on the function name and press F1 to see the correct number and types
of arguments. For functions you defined, check the definition.



too few constraints

This error marks a find or Given with fewer constraints than variables to be solved. Add dummy
constraints or decrease the number of variables to be solved for.



too few elements

This error message marks a Fourier transform, cubic spline, or linear interpolation function applied
to a vector with too few elements.

Splines and linear interpolation require vectors with at least two elements. Fourier transform
functions and their inverses require at least four elements.



too few subscripts

You used one subscript on a matrix. You must use two subscripts separated by a comma to specify
a matrix element.



too large to compute

Mathcad was unable to compute an array or matrix because of insufficient memory. Try to free up
some memory by making the array or matrix smaller or by deleting any large bitmaps, arrays, or
matrices.



too large to display

You tried to display a vector or matrix bigger than Mathcad can display. Try breaking it down into
pieces before displaying it.



too many arguments
The indicated expression contains a function with more than the required number of arguments.

For built-in functions, click on the function name and press F1 to see the correct number and types
of arguments. For functions you defined, check the definition.



too many constraints

You included more than fifty constraints in a solve block.



too many subscripts

You used two or more subscripts on a vector.



too many points

You tried to plot more points than Mathcad can handle in one plot.



undefined (reverse video)

This variable or function is undefined. To define it, enter the variable or function name, followed by
a colon (:) and an expression or number for its definition.

This error often means you have typed an equals sign (=) instead of a colon to define a variable. To
define a variable, you must use a colon. The equals sign tells Mathcad to display a result.

You also see this message if you use a variable incorrectly in a global definition. If you use a
variable on the right side of a global definition, the variable must be globally defined above the
definition in which it is used. If you use a locally defined variable or a variable whose global
definition is below the place where it is used, Mathcad marks the variable as undefined.

NOTE: An undefined error is often an indication that another equation further up in the document
is in error. If this is the case, all expressions that use the expression in error will be displayed in
reverse video.



underflow

You evaluated an expression smaller in magnitude than the smallest positive number that Mathcad
can represent.



unmatched parenthesis

This expression does not contain equal numbers of ('s and )'s.



wrong size vector

This error marks a Fourier transform function whose argument has the wrong number of elements.
3 fft requires a vector with 2*n elements.
L ifft requires an argument vector with 2*n+1 elements, where n is a whole number greater than 0.

Use cfft and icfft for arrays and vectors of any size.

NOTE: Unless you specify otherwise, all Mathcad arrays begin with Oth element. If you are used to
thinking of arrays as beginning at the 1st element, reset ORIGIN to 1.



end of file

You have asked Mathcad to read more data values from a datafile than there are values in the
datafile. For example, if your datafile has ten numbers in it, and you type...

i:1;100
x:READ(file)[j

Mathcad places the ten numbers in the x vector and displays this message.



range not allowed

Mathcad displays this message when you use a range variable in an inappropriate place, for
example a solve block.

If you want to iterate with a solve block, try defining the function in terms of the solve block and
using that function for iteration.









